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This Brief Guide

Objective The objective of this brief guide is to enable you, as the user, to take the initial steps with 
Caminax®. You learn the basic operation of Caminax® enabling you to proceed into more 
complex topics.

More detailed information can be gained from the Caminax® Reference Manual and 
through user training.

Copyright © Copyright FiberVision GmbH, Würselen, Germany. All rights reserved.

This publication must not be copied or made available to third parties in whole or in part 
without the express permission of FiberVision GmbH. 

Liability exclusion FiberVision GmbH does not accept any liability for any steps beyond those described in 
this brief guide. If you require more information, please refer to the Caminax® Reference 
Manual or ask for assistance.
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Basic information

What is 

Caminax®?
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n Caminax® is a complete real-time machine vision system for in-line quality control and 
gauging tasks. 

Caminax® consists of the following components:

■ Smart camera with an integrated processor

■ Keypad
■ Cables

■ Break-Out Modules for cabinet integration (optional)

Caminax® is able to perform industrial inspection tasks using state-of-the-art machine 
vision technology. 

Proper Use Caminax® is used for real-time industrial testing and measuring tasks. The Caminax® 
process interface consists of digital in- and outputs. The inspection is started using a trig-
ger signal coming from external devices. A camera image shown on a video display and a 
keypad are used as user interface. The inspection tasks are parameterized using the func-
tion Modules of the Caminax® software. 

What are Tasks? 
What are Modules?

The whole testing sequence to be performed for the inspection of a certain product is 
called Task. The Task includes image taking and communication actions, too. A Caminax® 
Task is created by adding small functional units – so-called Modules – step by step. The 
Modules of a Task are executed sequentially in the inspection mode. 

Every new Task consists of two basic Modules right from the start: The Image Module and 
the Result Module. These two Modules are needed for each possible Caminax® Task: The 
first one takes the image to be processed. A Task without image taking does not make 
sense since Caminax® is an image processing device. The Result Module is used to com-
municate the inspection results to external devices, e.g. a PLC. An interface to the outside 
world will always be necessary since Caminax® is a testing tool for automated fabrication. 
Application dependent adaptations are made by adding and configuring additional Mod-
ules.

List of Caminax®

Modules
Image Image capture, flash control and process synchronization

Result Links the Results of the several Modules, sets digital outputs and time 
delays

Brightness Determines and checks the mean image brightness

Area Counts the number of pixels in an area (Pixel counting)

Color Tests color in the testing area

Position Detects the position of an edge and makes this value available to sub-
sequent Modules as position reference

Points Finds one or more object edges along a straightline or along a circle

Straightline Tests the straightness and angle of a straightline

Circle Tests the diameter and roundness of a circle

Vector Calculates a vector from two points. The distance and angle are testing 
criteria.

Module Function
Issue: 2009-01-28
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Installing and starting the Caminax® 

Step 1: Connect 

Caminax®
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® Connect the components with the cables as shown:

B1A1 Connector to the round plug of the keypad cable

B1B1 DB9 plug for the keypad

B1A2 Connector for the round plug of the SVGA cable 

B1B2 DB15HD plug to connect a SVGA video display with 4:3 ratio

B1A3 Connector for the round plug of the Power/PLC cable

B1B3 Green flat plug to connect FV-EXT1 Break-Out Module

B1C3
Optional: 24 VDC power unit plug  
(black to GND | 3 wires red/blue, red, gray/pink to +24 V)

r
Optional: Connector to the round plug of the LAN or RS232 (V.24) 
cable. The cable type depends on the Caminax® model used.

r

B1A1

B1A3

B1B3

B1C3

B1B1

B1B2
B1A2

Item Connection / explanation
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Step 2: Screw on 
the Lens
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1 Remove the protective cap from the C-mount thread of the lens.

2 Screw the lens onto the C-mount thread of Caminax®.

3 Remove the protective cap from the object-side of the lens.

Step 3: 

Start Caminax®
 Caminax® shows the following user interface on the video display after power on.

D E

C A

B

F

A Caminax® logo D Camera image area

B Menu area E Task or Module list (Teach-In mode)

C Area for statistics F Control values associated to keypad 
function keys F1  to F4  

The optics are not part of Caminax®. The lens to be used depends mainly of the applica-
tion. Please contact your Caminax® dealer. He will give you comprehensive advice on the 
choice of optics.
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Using the Keypad
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d The keypad is the operator interface to Caminax®. All entries are 
made using the keypad keys. You navigate through the Caminax® 
system menu shown on the video display using the keypad. You also 
use it to set-up Tasks, Modules, Windows, texts and parameters.

Using the 
Navigation Keys â/ã

(arrow down/up)

Scroll vertically through the menus
Scroll through the Task and Module lists
Step vertically through lists
Move Windows (Regions Of Interest, ROIs) vertically
Change the height of a Window (ROI)

[/]

(arrow left/right)

Step horizontally through lists
Change values of horizontal sliders
Move Windows (Regions Of Interest, ROIs) horizontally
Change the width of a Window (ROI)

(Central key)

Step through the alphabet when entering text
Set the Result logic for the outputs in the Result Module
Select elements from lists

Using Function 
Keys

 Esc Cancel input or selection

 Enter Confirm input or selection

F1  Show/hide overlays

F2  Show/hide the user interface

F3  Change the step direction when entering text

F4  

Change the step width for numerical entries and Task (ROI) settings. 
Supported values are: 1 pixel (fine), 10 pixels (medium) and 25 pixels 
(coarse). The corresponding step widths for angles and directions are: 
1/10° (fine), 1° (medium) and 2.5° (coarse).

  

Enter or Exit 
Sub-Menus

Select a Menu Item

Suppose you want to push the [Create] button.

1 Position the cursor with â/ã onto the  button in menu area B.

2 Push Enter on the keypad.

Example: Cancel a previous action

Suppose you want to go back to the top menu.

■ Push Esc on the keypad.

Interact with Dialogs Example: Manage a YES / NO query

The cursor is in the correct position when the [Create] button is highlighted. 
6 Issue: 2009-01-28
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Suppose you want to push the [YES] button.

1 Position the cursor with [/] onto the  button. 

2 Push Enter on the keypad. 

Example: Confirmation dialog 

In a confirmation dialog you only see the  button.

■ Push Enter on the keypad.
The dialog recognizes the confirmation and closes.

Set Values and 
Tolerances
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Example:   Set the Exposure Time

Suppose you want to change the exposure time in the Image Task. 
You’ve already entered the Shutter sub-menu.

1 Move the slider with [/].
You see the value under the setting element.
You can change the step width with F4 .

2 Push â/ã to select the  button.

The  button is selected as soon as it is 
highlighted.

3 Push Enter on the keypad.

The value chosen for the exposure time will be used from now on.

Set the
Nominal Value

and Tolerances

Step 1: Set the Nominal Value and Tolerances

1 Add the Area Module to your testing Task.

2 Enter the Area menu.

3 Push the  button in the Area Module.

4 Confirm the following messages with Enter.

Caminax® saves the current value measured as nominal value, and sets the toler-
ances to default values.

You can change the values which were automatically pre-set by :

Step 2: Change the Nominal Value and Tolerances

1 Push the  button in the Area Module. 

2 Choose the Value slider with â/ã.

3 Change the nominal value by using the [/] keys. 

You can change the step size with F4 . 
The numerical value is displayed right under the correspond-
ing slider. The values for the lower and upper tolerance limits 
(Min/Max) will be adjusted automatically as soon as the nomi-
nal value is changed.

4 The tolerances are adjusted by choosing the corresponding 
slider using â/ã. The value itself is set with [/], again. 
The step width is set with F4  right as before. 

5 When all settings are done, push â/ã to select the 
 button. The selected button is highlighted. 

6 Push Enter on the keypad. The nominal value and its minimal and maximal tolerances 
are set. The Area Module is shown again.

The cursor is in the correct position when the [YES] button is highlighted.

The nominal value, e.g. for an area, is set using the Learn function. Caminax will auto-
matically set tolerances to default values when setting the nominal value.
Issue: 2009-01-28
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Edit Characters
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Example: Change a Task Name

1 Select  in the Task menu.

2 Push Enter on the keypad. 

The Task list appears.

3 Position the cursor onto the Task to be edited using the â/ã keys.

4 Choose the letter to be edited with the help of the [/] keys.

5 Step through the alphabet with the  key located centrally on the keypad.

The order of appearance is: upper case letters, underscore, lower case letters, space, 
special characters, numbers.
Push F3  on the keypad to change the step direction.
Push Esc on the keypad to abort.

6 Push Enter on the keypad to confirm the present names.

This function is used to change the Caminax® Task or Module names. The symbols of the 
Result logic in the Result Module are modified in the same way.
8 Issue: 2009-01-28
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Set-Up Tasks, Modules and Windows
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through the menu: 

Run Execute the selected Task

Stop Stop the execution of the current Task

Open Open a Task for editing
Create Create a new Task

Copy Copy a Task

Delete Delete a Task
Name Edit a Task name

Autostart Define the Task to be automatically started on power-on.

PLC start Control the execution of Tasks through digital inputs
Save Save all settings and Tasks

Calibration Global calibration for all Caminax® Tasks

Transfer Data and image exchange between Caminax® and a PC

Language Change the language of the user interface
Info Show the Caminax® version information

Execute a Task 1 Position the cursor on Task   with the keypad keys â/ã then push 

Enter twice on the keypad.

Congratulations! You have just started executing a Task for the first time.

2 Place a hex nut as a testing object in the field of view of Caminax®. The nut should be 
illuminated by a bright backlight.

3 Adjust the lens. Turn the aperture ring of the lens to adapt the image brightness. The 
focus ring is used to adjust the image sharpness. Try to receive an image similar to the 
one shown below.

The image shows the object we are inspecting. It is the nut in our example. In the dis-
play area above the image, you see the time needed for the previous testing run 
(Duration) and the number of inspections performed so far (Total).

4 To stop the execution of the Task, position the cursor on Task   
with the keypad keys â/ã, then push Enter on the keypad.

You see a picture of the nut on the screen. We use the nut as an example in this brief 
guide to show how easy it is to create testing Tasks with Caminax®.
Issue: 2009-01-28
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Insert and Edit 
Modules 
in a Task

1
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Example:  

The cursor jumps into the Task list. 

2 Position the cursor with â/ã onto the Task you want to open, then push Enter.

You see the list of Modules used in the Task.

As every newly created Task, your Task already contains the Image and Result Mod-
ules. You can select from the following items using theâ/ã keypad keys. 

Edit Edit a Module to set parameters

Add Add a new Module and edit it

Move Cut a Module and paste it elsewhere
Copy Duplicate a Module

Delete Delete a Module

Update Update a Task (All Modules are executed once)
Statistics Reset the Task statistics

Calibration Calibrate Caminax® for this Task

Cancel Cancel changes and exit the menu

OK Confirm changes and exit the menu

3 Push Module   to insert a new Module.
10 Issue: 2009-01-28
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4 Move the cursor with â/ã keys to select the item where you want to insert the new 
Module. The new Module is always inserted previous to the selected one.

The cursor is automatically positioned on Result in new Tasks since all new Modules 
are added between the two initial Image and Result Modules.

5 Push Enter. A selection dialog appears, where you specify the Module to be added.

6 Move the cursor with â/ã onto the Module which you want to add, then push Enter.

Now set-up the Module in according to your requirements. 

The set-up of the Area Module is explained in detail in the section Example of a Test-
ing Task (Page 14).
Issue: 2009-01-28
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Window 
Configuration and 

Usage

What are Windows?

Windows are Regions Of Interest (ROIs) of the image in which Modules perform their 
machine vision functions. Modules using Windows are:

■ Position Module (Edge detection)
■ Points Module (Edge counter)

■ Area Module (Pixel counter)

■ Brightness Module

The Windows are visualized in the image while they are configured. Caminax® features 
the Window geometry adaptation suitable to a particular Task. 
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Area based Modules such as Area, Brightness and Color support Windows with various 
shapes. Turned rectangles, circles, rings, circle and ring segments are supported.

Edge based Modules such as Position and Points, support rectangular and ring shaped 
Windows, too. Additionally, their Windows specify a probe direction (search direction). 
This direction defines the search path for edge detection. 

Multiple Windows in a Module

A Module may contain any number of Windows. You can create Windows one by one or as 
a group. The Window geometry can be configured individually for each Window. Changes 
can be performed on a single Window or collectively on a group of Windows. 

Set-Up Windows
■ We show the Window menu of the Area Module. Push the  button 

to activate the Window menu. The Window tool opens. When setting up the Window, 
Caminax® already performs the corresponding image processing Task of this Module, 
and displays the Result. Thus, the Window colors shown may vary depending on the 
Module’s set-up.

The Window menu is shown below. 

The Window menu items are selected using â/ã. The options available are: 

Outside / Inside 

Most settings apply on the whole Window. The whole Window is 
activated if both Outside and Inside are set. The size of just the 
outer or inner contour can be modified by activating only the corre-
sponding check-box.

Shape  
Toggle the shape of the Window between an ellipse and a rectangle. 
Push Shape, then toggle using the  key in the middle of the key-
pad. Push Enter if finished.
12 Issue: 2009-01-28
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Some options are not available for all Module types.

Position / Size 
Set the location, define the size of the Window. Use the with the â/
ã/[/] keys. The step size is switched between 1, 10 and 25 pix-
els using the F4  key.

Direction Rotates the Window using the [/] keys.

Start Angle / 
End Angle 

These features apply to circular or elliptical Windows. A segment of 
the base geometry is specified. Change the start or end angle using 
the [/] keys.

Clone Copy Windows

Delete Delete Windows

Cancel Cancel the changes and exit the Window tool

OK Confirm changes and exit the Window tool S
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Example of a Testing Task

The following sections use a hex nut as an example to show the simple creation of testing 
Tasks with Caminax®. 

The task is to check if there is a hole in the nut (area P in the figure is bright) or not (the 
hole is dark). In the latter case, the nut is faulty. Caminax® should signal this state to a 
PLC with the help of the digital outputs. 

P

Solution Idea We solve this testing task by checking the size of the bright area. A large amount of 
machine vision appliances are based on brightness checks in certain areas. Thus, this 
example shows a fundamental approach to visual inspection in industrial environments.

Implementation First of all, we create an empty Task. Then, we configure the Task by adding suitable Mod-
ules. Caminax® comes with a range of Modules. Each of them is made for a specific task. 
Then we start the inspection Task and integrate it into our production facilities:

1 Empty Task … You create an empty Task. An empty Task already consists of Image and the 
Result Module.  
Ú Exercise Step 1: Create an Empty Task (Page 15)

2 Image … Caminax® captures an image of the nut.  
Ú Exercise step 2: Configure the Image Taking (Page 17)

3 Area … You add the Area Module and configure it. You define the area where you 
expect the hole of the nut.

4 Ú Exercise Step 3: Insert the Module »Area« (Page 20)

5 Result … You assign digital outputs to the inspection results.

6 Ú Exercise Step 4: Evaluation Set-Up (Page 25)

7 Run … Run your Task.  
Ú Exercise step 5: Run the Task (Page 30)

8 Integrate … Integrate the inspection into the process environment.  
Ú Exercise step 6: Exercise Step 6: Integration into the Process Environment 
(Page 31)
14 Issue: 2009-01-28
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Exercise Step 1: Create an Empty Task

Prerequisite The Task menu shown below appears on the video display if Caminax® is powered-on for 
the first time. Some other screens may appear if Caminax® was used before. In this case, 
exit the Window or Module menus using Cancel or OK and go back to the Task menu. It 
does not matter if the Task list is not empty.

Create and Save a 
new Task

1 Position the cursor onto Task   with the â/ã keypad keys, then 
push Enter on the keypad.
A new Task appears in the Task list. 

2 Push Task  . 

Attention: equipment could be damaged!  
Caminax® must not be powered off while saving.
Issue: 2009-01-28
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Caminax® queries whether you want to save all.

3 Push .

Caminax® replies with: All saved. 

4 Push .

Finished. You have created and saved your first testing Task, now.

The Save function applies on all changes. All Tasks including their present configura-
tion as well as statistics are saved power fail save in the Caminax® hardware. 

The empty Task just created is already able to run since it is not completely empty, in 
fact. It already contains two Modules: An Image and a Result Module.

5 Continue with Ú Exercise step 2: Configure the Image Taking (Page 17).
16 Issue: 2009-01-28
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Exercise step 2: Configure the Image Taking

Any machine vision Task starts with an image taking. Thus, we configure the image at 
first. This is done in the Image menu.

Basic Information – 
»Image« Menu
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Demo Image 
Saved Image 
New Image 

These buttons define the image source to be used. The Demo Image is 
not yet available. The Saved Image is an image taken by Caminax® 
which was saved before. New Image is the option to be chosen for 
inspection uses. 
Choose New Image.

Adjust 

Toggle between live and the still images. It is a useful tool for setup. In 
the live mode, you see the effects of lens adjustments. The sharpness 
of the image will change if you turn the focus ring and the brightness 
will change if you turn the aperture ring. In the static mode, you can 
have a close look to what the camera sees. Maybe, there are some 
unexpected bright or dark areas which will disturb the inspection?

Flash Enable / disable a flash light trigger signal. The output OUT1 is set dur-
ing image exposure. 

Exposure Set the exposure time for the image taking. 

Display 
✓: Enable display image update during measurements.
 is less comfortable but faster. 

Choose ✓.

Trigger 
✓: Enable external trigger input from IN0 to start the Task.

: The Task is executed continuously.
Choose  if no PLC or other triggering device is connected.

Test Capture an image from the image source specified above and tests this 
Module.

Save Image 

Save the present image on the internal flash card. This image can be 
re-loaded with the Saved Image option at a later time. You should save 
the current reference product when you set-up a new Task. This helps 
to analyze future changes of the testing equipment or of the product 
itself. In future, you will be able to compare the reference set-up image 
to the production images taken then.

Cancel Cancel all changes and exit the menu.

OK Confirm all changes and exit the menu.

Set Parameters for 
Image Taking

To enter the image Module from the Task list do the following:

1 Position the cursor in the Module menu to the Open button by using â/ã and push the 
Enter button.

2 If there is more than one Task: Select the Task to be edited using â/ã.

3 Push the Enter button.

4 The Module list of the Task is shown. As any new Task, our empty Task already con-
tains the Image and Result Modules.

5 Push Module  .
Issue: 2009-01-28
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The cursor jumps into the Module list. 

6 Position the cursor with â/ã onto the Image Module in the list, then push the Enter 
key on the keypad.

The Image set-up menu appears. 

7 Click Image  .

8 Push Image  , to adjust the position and illumination of the nut, 
then push Image   again.
18 Issue: 2009-01-28
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9 Push Image  , check and adjust the image brightness with 
â/ã, then push Enter.

10 Keep the Flash option switched off. We will use a permanently shining illumination in 
this example. 

11 Keep the Trigger option switched off. The inspection Task will run continuously without 
an external input signal. 

12 Push Image  .

Caminax® captures a new image and keeps it in the memory as reference to set-up 
the rest of the testing Task.

13 Push Image  .

You are back in the Module menu.

14 Continue as with Ú Exercise Step 3: Insert the Module »Area« (Page 20).

The camera exposure time is set with . A longer exposure time 
makes the image brighter. Consider that a long exposure time increases the Task pro-
cessing time. Additionally, motion blur may occur with moving parts or vibration.

The effective lens aperture influences the image brightness, too. This aperture is set 
using the aperture ring of the lens. Consider that the depth of sharpness will 
decrease if you create brighter images with the help of the aperture ring settings. 

Last, but not least the illumination brightness has a major impact on the image bright-
ness and contrast.
Issue: 2009-01-28
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Exercise Step 3: Insert the Module »Area«

In our example, we will check the area of the nut’s hole. We need a pixel counting function 
for that. This function is provided by the Area Module.

Basic Information - 
»Area« Menu
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Window 
Define one ore more Regions Of Interest (ROIs) within the camera 
image where this Module shall determine the size of an area with a cer-
tain brightness.

Tracking 

The Window’s X and Y positions may be shifted according to the 
object’s position changes detected by preceding Modules. The area 
detection threshold may be adjusted according to the all-over image 
brightness, too. The prerequisite for that is, that this all-over brightness 
is detected previously in a suitable Module. 
The Tracking is not used in this exercise.

Threshold 

The gray values stand for a certain image brightness. E.g., the gray 
value 0 represents the color black and the gray value 255 represents 
white. All the values in-between represent different types of gray. Lower 
values are darker and higher values are brighter. 
In the Threshold menu you define the interval of gray values to be used 
for pixel counting. 

Relative /
Absolute

Determine the way the tolerances are set. 
Relative defines that the area determined is tolerated as a percentage 
of the whole Window. 
Absolute means that the actual number of pixels within a certain range 
of gray values will be compared to the number determined with the ref-
erence object. 
Keep the Relative mode active in this exercise.

Learn 
Execute the pixel counting with the present setting on the reference 
image.The resulting area is supposed to be GOOD. The tolerances are 
automatically pre-set in an interval around the GOOD value. 

Tolerance The automatically generated tolerances from Learn can be edited for 
fine tuning in the Tolerance function. 

Test 
Perform a test run of the Module with the current settings. The Module 
Results are shown on the display. The Results are made available to 
successive Modules. 

Display 

✓: Enable the Result visualization of this Module while the inspection is 
running. 
 No Result visualization is shown from this menu. This option is cho-

sen to speed up the Task execution. This option is also chosen for 
assisting Modules which should not attract the user’s attention during 
inspection.
Keep the Display ✓ checked in this exercise. 

Cancel Cancel all changes and exit the menu

OK Confirm all changes and exit the menu

 Area Module has the following functions:

Step 3A: Insert the 
»Area« Module

1 Push Module  .
The cursor jumps into the Module list. 

2 Push Enter. 
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Version: 3.5.9.B 



BRIEF GUIDE
Exercise Step 3: Insert the Module »Area«Caminax®
3 Select 3: Area in the dialog, then push Enter.

The Area set-up menu appears. 

A

The figure shows the Window A, consisting of an outer and inner contour. You will 
adjust this Window in a suitable way in the next steps.

Step 3B: Position the 
Window 

1 Push Area  .
The Window tool opens. See Window Configuration and Usage (Page 12).
The area used for pixel counting is colored and semitransparent. It is the area 
between the inner and outer Window contour.
Issue: 2009-01-28
Version: 3.5.9.B 

21



BRIEF GUIDE
Exercise Step 3: Insert the Module »Area« Caminax®
In our example we will position the ring into the middle of the hex nut hole. Then we will 
resize it in a way that the outer contour fully covers the hole. Finally, we scale the inner 
contour down to zero. Thus, we create a circle from the ring.

2 Push Window  , then position 
the Window with the  â/ã/[/] keys approximately 
in the center of the hole under test, then push Enter. 
Change the step width with F4 , as pleased.

The present step size is shown in the display header: 
<F4> Step.

3 Push Window  , then enlarge 
the Window with the â/ã/[/] keys so that the 
outer contour covers the nut hole, then push Enter. 

4 Push Window   to keep just 
Inside checked.

5 Push Window  , then mini-
mize the inner contour until it has vanished. Use the 
ã/[ keys, then push Enter. 

Select the step size 1 ( F4  ) to erase the inner con-
tour completely. The circle creation does not work 
with other step sizes.

6 Push Window  .

The Window tool closes, and Caminax® returns to 
the Area menu.

Step 3C: Set-Up 
the Tolerances of 
the Area Module 

In our example, the Area Module should only count the bright pixels of the hole to be 
inspected. The dark pixels of the actual nut should not be counted.

Caminax® counts medium gray pixels by default. In the following step, you will adjust the 
interval of gray values used for pixel counting in a way that Caminax® counts just bright 
pixels as they appear in the hole.
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1 Push Area  .
Increase the Max-value until the entire hole appears colored. The color may change 
between red, green and yellow. This is not relevant, now. You will receive a completely 
colored hole with a Max-value less than 255 if the hole is just bright, but not com-
pletely white. No additional colored points should appear if you increase the Max-
value to 255 in that case. Thus, you can keep the value of 255. 255 is always a good 
Max-value, if you want to count bright pixels. (By the way, 0 is always a good Min-
value, if you want to count dark pixels.) 

The Min-value is pre-set to 63. Thus, it is possible that some areas of the nut itself are 
colored, too. This is the case if the nut appears gray and not quite dark in the image. 
You can exclude these relatively bright areas on the nut from pixel counting. Just 
increase the Min-value until you see just the hole colored.

Now we have what we want:

The colored area covers just the hole. Thus, the hole size will be determined during 
inspection. 
Push Enter. 

2 In the next step we tell Caminax® that the present number of colored pixels is the 
expected one which should be treated as GOOD. Just push Area  

, then confirm the messages with Enter.

The colored pixels are green, now. Caminax® uses the present number of pixels as 
reference from now on. The tolerances are automatically pre-set with values close to 
the reference value. 

3 Push Area  , then reduce the Min-value and then increase the 
Max-value.

This increases the tolerance range related to the default settings created on Learn. 
This makes the system more robust. Just significant area changes will cause BAD 
sorting Results.
In the screenshot shown below, Caminax® detected bright pixels on 63% of the Win-
dow area. The tolerances have been adapted manually. Now, a bright area covering 
50% to 80% of the Window area will provide a GOOD sorting Result. You will receive 
Issue: 2009-01-28
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another Value if you perform the exercise with your Caminax® since your camera 

image and your Window will look different, too.

Push .

4 Push Area  .

A Result screen opens. It shows the settings of the Area Module and the center of 
gravity of the area found. 

Push Enter to close the Result screen.

5 Push Area  .

The newly added Area Module appears as a part of the Task. The Module list shows 
that your Task consists of three Modules.

6 Push Module  .

Caminax® saves the Module settings. The Task menu re-appears.

7 Continue with Ú Exercise Step 4: Evaluation Set-Up (Page 25).
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Exercise Step 4: Evaluation Set-Up

In our example, Caminax® will set a digital output depending on the Result of the Area 
Module. This is configured in the Result Module.
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e Basic Information – 
Result Module 

Every Task ends up with the Result Module. The Result Module configures the digital out-
put states of the Caminax® hardware depending on the inspection results. Thus, the 
Result Module configures the interface to the outside world.

You can configure the usage of the outputs available according to your needs. 

■ Example 1:   You configure the sorting outputs GOOD, BAD and REWORK.
■ Example 2:   You define logic conditions for WARNING and MACHINE STOP outputs. 

You specify output bit patterns for warning and intervention limits.
■ Example 3:   You define logic combinations to identify different product variants.

When do Modules return the Result BAD?

Modules return the Result BAD when their tolerances are exceeded.

Area The pixel number in the Window is too high or too low 
Brightness The Window content is too bright or too dark

Position No edge is found

Points The number of edges is too high or too low
Circle The tolerances for diameter or eccentricity are exceeded

Color The color tolerance is exceeded

Straightline The tolerances for straightness or angle are exceeded
Vector  The tolerances for distance or angle are exceeded

The Module’s Result is indicated by the color of the testing Window.

Green Module is okay, the product checked is GOOD.
Yellow Module is still okay, but close to the limit. The product is GOOD.

Red Module is not okay, the product checked is BAD.

The Result menu features the following functions: 

Logic Set-Up the Result logic

Delay Insert a time delay

Test Test the Result logic
Display Reserved

Cancel Cancel changes and exit the Result menu

OK Confirm changes and exit the Result menu

Color Result of Module
Issue: 2009-01-28
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Basic Information 
- Elements of the 

Result Menu
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The hardware outputs OUT1, OUT2 and OUT3 can be configured depending on the 
inspection results. The outputs are digital. They have two states: 0 (Low) and 1 (high). The 
output states are updated as soon as the inspection Task has finished. Caminax® indi-
cates this using OUT0, the ready/busy signal.

The possible output states C for a certain Task are defined in the logic block A. The 
logic block consists of several logic units B. A logic unit defines an output state depend-
ing on certain Module Results D. Caminax® does not check if the output definitions of the 
logic units are non-contradictory. A well defined output is created anyway since Caminax® 
evaluates the logic units from the left to the right. The output of e.g. OUT2 will be 1 if the 
logic unit at the very right side configures it that way. All possible logic Modules closer to 
the left side assigning a 0 will have no influence in that case. 

At the very left side of the logic block there is a logic unit which cannot be edited. It 
assigns the state 0 to all outputs (0), no matter what the Module outputs are (×). The logic 
units closer to the right side are pre-configured to keep the output states as they were 
defined earlier in the logic block (×). Thus, the outputs will be set to 0 if the Result Module 
keeps unchanged.

The hardware outputs are defined using the following states:

Output symbol Description

0 This logic unit sets the corresponding Caminax® output to 0 (LOW).

1 This logic unit sets the corresponding Caminax® output to 1 (HIGH).

× This logic unit does not change the corresponding output state. The 
states defined on the left-hand side are used.

A conditions for the output of a logic block are defined in the lower part of that block. Here, 
the Modules of a Task are shown. You can assign the following symbols to each Module:

Result symbol Description

+ Module must be GOOD.

– Module must be BAD.

× Module has no impact on the output state defined above.
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If you assign the + or the – symbol to more than one Module all conditions have to be ful-
filled at the same time to provoke an output state change. The output state will remain as 
it was defined closer to the left side of the logic box if just one Module Result is different 
to the specification in the logic unit.

Output statistics in Caminax®: An internal counter is incremented by one each time a cer-
tain output is set. The counters for the three user-configurable outputs are shown at the 
top of the Caminax® screen. 

Step 4A: Open the 
»Result« Module

Let’s go on with the exercise. We are in the Task menu. 

1 Push Task  . 

2 Position the cursor with â/ã onto your Task in the Task list, then push Enter.

3 Push Module  .

The Module list of your Task is shown. 

4 Position the cursor on 3:Result in the Module list using â/ã. Confirm with Enter.

The Result menu for appears. 

Step 4B: Set the 
Result Logic The digital Caminax® outputs shall be set depending on the Area Module result. If the 

result is GOOD, we want to set OUT1 to 1. If the result is BAD, OUT2 will be set to 1, 
and OUT1 should stay at the 0 level. 
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The table above shows a logical configuration which defines the behavior desired. In the 
first editable row on the left side Area is assigned to +. All other Modules have their default 
state x. This means that the output states are defined for the case that the Area Module 
returns GOOD. In that case, Output 1 is set to 1. Output 2 should be 0 in our example. We 
do not have to specify Output 2 explicitly in that row since all outputs are pre-set with 0.

Correspondingly, it is sufficient to associate Output 2 = 1 with Area = - in the next row.

1 Push Result  .

2 Select the first editable column on the left side using [/]. 

3 Select Output 1 using â/ã. 

4 Push the  key on the keypad until the 1 appears. 

5 Select the Area Module with â/ã.

6 Push the  key on the keypad until the + appears.

7 Go to the next row with ].

8 Set Output 2 to 1 and Area to - as described in above.

9 Push Enter. 

Step 4C: Test the 
Result Module

1 Push Result  .
The present results of all Modules are shown. The associated output states defined in 
the logic block displayed, too.

Push Enter. 

2 Push Result  .

3 Push Module  .

The changes made are automatically used by Caminax® if a Task or Module is exited 
using the OK button. Still, they are not saved permanently on Caminax®. The power-fail 
save storage has to be performed by the user.
28 Issue: 2009-01-28
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Step 4D: Save Task

Caution, equipment can be damaged!  
Caminax® must not be switched off while saving.

1 Push Task  .

2 Push .

3 Confirm the message with .

This action saves all Tasks and their settings power fail save. 

4 Continue as with Ú Exercise step 5: Run the Task (Page 30).
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Exercise step 5: Run the Task 

Let’s get the previously defined Task running!

Run Task and 
Check Result

1 Push Task  . 

2 Position the cursor with â/ã onto your Task in the Task list, then push Enter.

The execution of the Task starts.

Take a look at the statistics shown in the upper area of the Caminax® screen. 
Output 1 shows the number of GOOD counts, and Output 2 the number of BAD ones, 
respectively. We configured the outputs in this way for our testing Task.

3 Check the color of the testing Window.

Green Value is within the threshold.
Yellow Value is within the threshold, but close to the limits. Warning.

Red Value surpassed the threshold. Error. 

 
Color Result of Module
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Exercise Step 6: Integration into the Process Environment

The digital in-and outputs configured in the software have to be wired electrically, too. The 
Power/PLC cable provides the interfaces. The wiring is done easily when using the FV-
EXT1 Break-Out Module. It has signal lamps to visualize the input and output states and 
provides switches to simulate PLC action. 

One output is used to synchronize a flash lamp with the image taking in many cases. The 
other outputs are available to exchange sorting results with the machine control, e.g. a 
PLC. 

One input is used to start the Caminax® testing Task in most applications. The other ones 
may be used to switch automatically between different testing Tasks.

Please refer to the Caminax® Reference Manual and the manual of the Break-Out Mod-
ule for more detailed information.
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Technical Appendix

Technical Data

Processor 
(MIPS) 1200 3200 8000 3200 8000

Sensor

1/3"-Sony
640 × 480

Mono-
chrome 

CCD

1/2"-Sony
782 × 582

Color

CCD

1/3"-Sony
640 × 480

Monochrome
CCD

1/3"-Sony
1024 × 768

Monochrome
CCD

Evaluation Area 588 × 476 Pixel 636 × 480 Pixel 952 × 768 Pixel

Max. Frames 
per Second 25 Hz  10 Hz 52 Hz 20 Hz 

Exposure Time 25 µs up to 5 sec

Processor Texas Instruments DSP TMS320C6000 Series 

Memory Size
RAM / Flash

16 MB / 
2 MB

32 MB / 
4 MB 32 MB / 4 MB 32 MB / 4 MB

Memory Card No Yes Yes Yes

Interfaces

RS-232 Ethernet 100 Mbit

Power supply 24 VDC ± 20%, max. 5.5 W

4 digital inputs, opto-decoupled

4 digital outputs, 400 mA, opto-decoupled

SVGA/Video

Keypad

Trigger

Flash 

Lens Adapter C-Mount

Operating Con-
ditions

Max. 80% relative air humidity, -5°C … 45°C (23°F … 113°F)

Shock acceleration <70 g

Vibration <7 g (11-200 Hz)

Dimensions 111 × 50 × 45 mm (without optics)

Weight Approx. 350 g

Type 612S 812 C 
(color)

632 680 1032 1080
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Overview of Interfaces

Overview of 
interfaces 

1A

2A

4

3A

Trig. 6-pin 
Hirose  Socket Keypad cable, 5 m DB9 Keypad connector

Video 10-pin 
Hirose  Socket SVGA monitor cable, 

5 m DB15 SVGA video display connector

I/O 12-pin 
Hirose   Plug Power/PLC cable, 5 

m open Power supply and PLC commu-
nication

RS-232 6-pin 
Hirose Plug V24 (RS232) cable, 

5 m DB9 Serial data exchange 

LAN 6-pin 
Hirose Plug LAN cable 5 m RJ-45 Ethernet data exchange

Plug Sign on 
camera

Type of 
connec-
tor

Camera con-
nector

Name of the cable / 
length

Outgoing cable 
connector

Function

1A

2A

3A

 
Pos. 4 type-related (RS-232 or LAN)

 
order separately

4

4
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Digital Interfaces 

Pin assignment 
»Power/PLC (I/O)«

q 24 V IN PLC Power supply digital outputs red —

w 24 V IN camera Power supply camera red/blue —

e Common GND IN for 
camera and PLC black —

r IN1 Digital program selection pink —

t OUT3 User configurable output yellow —

y OUT2 User configurable output green —

u OUT1 Flash output or user configurable 
output brown —

i OUT0 Ready/busy signal white —

o 24 V IN PLC Power supply digital outputs grey/pink —

a IN3 Digital program selection violet —

s IN2 Digital program selection blue —

d IN0 Trigger or digital program selec-
tion grey —

For all Caminax® types

o
i
u

yr
e
w

q

ds
a

t

Camera Line Peripherals

View of the solder side of the socket open

Power Supply A polarity reversal protection diode prevents damages from accidental polarity reversal of 
the power supply. 

Camera connector Function Peripherals

Pin Signal Cable color Pin

All three 24 V wires have to be connected to operate Caminax® properly:
– red  q … for PLC signals (24 V IN PLC)
– red/blue w … for camera (24 V IN camera)
– grey/pink o … for PLC signals (24 V IN PLC)
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Using the 
Digital IOs

Example  
8

OUT0

OUT1

OUT2

OUT3

IN0

IN1

IN2

IN3

PLC

Caminax

Task
selection

Ready/Busy

lighting

Strobe

Event
(e.g. switch,
photoelectric 
sensor signal)

Trigger 

Trigger

Result Logic   
for 
evaluation 

(Trigger  new image)

Digital Inputs

Available Inputs

Caminax® has 4 digital inputs.

IN 0 [Trigger 
new image]

Input 0 has a double function. It is available for the digital selection of 
the Task by the PLC, and also reserved for the start signal (new image 
trigger signal).

IN 1, 2, 3 Available for the digital Task selection (PLC start).

Digital Inputs Usage
■ You activate the new image trigger by switching it from LOW to HIGH.
■ Please refer to the Reference Manual for changing the Task by external digital inputs.

Inputs - Technical Data 

Operating Voltage 24 V, PLC compatible
Galvanic Isolation Yes, optical de-coupled

Input Protection Circuit Yes

Max. Input Current at 24 V 50 mA
Response Threshold (Input Detects HIGH) 8 V 

Input current at response threshold 1 mA

Internal Signal Delay Approx. 150 µs

 CAUTION

 Risk of destruction by overvoltage!  
 Voltages above 40 V can destroy the digital inputs and outputs.

Input Description

Parameter Data
Issue: 2009-01-28
Version: 3.5.9.B 

35



BRIEF GUIDE
Digital Interfaces Caminax®
Digital Outputs

Available Outputs

Caminax® has 4 outputs.

OUT 0 
[Ready]

Caminax® sets a this output high after having finished to process a 
Task. The signal is low while Caminax® is busy processing a Task. 

OUT 1 [Flash]
Output 1 is reserved for a flash trigger signal set during image expo-
sure if the flash mode is configured for image taking. The output usage 
is user defined if no flash is used.

OUT 2 The output usage is user defined.

OUT 3 The output usage is user defined.

Double Function of the Outputs

The outputs echo the inputs, if the inputs have been used successfully for a Task change. 
All outputs are set to 0 if the Task selected through an input code does not exist. 

Outputs - Technical Data 

Operating Voltage 24 V

Galvanic Isolation Yes, optical de-coupled
Current 150 mA per output (total 400 mA)

Switching Capacity Maximum 3.6 W

Protection against Inductive Loads Yes
Resistance when Switched On < 0.6 Ohms

 CAUTION

Risk of destruction by overvoltage! 
Voltages above 40 V can destroy the digital inputs and outputs.

Output Description

Parameter Data
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Keypad Connector

Pin Assignment 
»Keypad (Trig.)«

Camera Line Peripherals

View of the solder side of the plug

q
w

er
t
y

View of the solder side of the socket

1

9

qwert
yuio

Caminax® 612 S and Caminax® 812C

q Trigger IN – Green r

w +5 V OUT Brown i

e GND White t

r Keypad IN Pink q

t Trigger OUT Gray y

y Trigger IN + Yellow o

nc nc nc w

nc nc nc e

nc nc nc u

The pin assignment »Keypad (Trig.)« is depending on the Caminax® model used. 

Camera Con-
nector

Peripherals

Pin Signal Cable Color Pin
Issue: 2009-01-28
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Camera Line Peripherals

View of the solder side of the plug

q
w
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y

View of the solder side of the socket

1

9

qwert
yuio

Caminax® 632 / 1032 and Caminax® 680 / 1080

q V24 TxD Green w

w +5 V OUT Brown i

e GND White t

r V24 RxD Pink e

t Trigger OUT Gray y

y Trigger IN Yellow o

nc nc nc q

nc nc nc r

nc nc nc u

Keypad Usage
■ Connect the keypad cable between the camera and keypad. Finished. 

Camera Con-
nector

Peripherals

Pin Signal Cable Color Pin
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Video Output

Pin Assignment 
»SVGA Video«

Camera Line Peripherals

View of the solder side of the plug

q
w

e
rt

y

u
i

oa

View of the solder side of the socket

1

15

qwert

sdfgh
yuioa

For all Caminax® types 

q Green GND Green shielding u

w Green OUT Green w

e Red GND Red shielding y

r Red OUT Red q

t Vertical sync. GND Gray shielding s

y Vertical sync. OUT Gray g

u Horizontal sync. GND White shielding a

i Blue GND Blue shielding i

o Blue OUT Blue e

a Horizontal sync. OUT White f

nc Monitor ID nc r

nc nc nc t

nc Encoding nc o

nc Monitor ID nc d

nc nc nc h

Video Output Usage
■ Connect the SVGA cable between the camera and the cable of the video display. Fin-

ished. 
■ A video output cable with a DB15 plug instead of DB 15 socket is available optionally. 

This cable can be plugged into the video display directly.

Camera Con-
nector

Peripherals

Pin Signal Cable Color Pin
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Pin Assignment 
»RS-232 (V24)« 

Camera Line Peripherals

View of the solder side of the socket

y
t

re
w
q

View of the solder side of the socket

1

9

qwert
yuio

RS-232 (V.24) for Caminax® 612S

q RTS Yellow i

w TxD Brown w

e GND Gray t

r nc Pink nc

t CTS Green u

y RxD White e

nc DCD nc q

nc DTR nc r

nc DSR nc y

nc RI nc o

Serial Interface Usage

■ The RS 232 cable is available as an option. 
■ Uses of the cable:

❍ Configuration exchange with a PC. All Tasks and their settings can be stored on a 
PC for backup. Caminax® configurations can be cloned by loading the configuration 
from the PC to back to other Caminax® cameras. 

❍ Reference image transfer between PC and Caminax® 

❍ RS 232 based Task selection.

■ Connect the Hirose socket of the V24 cable to the camera, and the other end to the 
SUB-D socket on the PC. 

Depending on the Caminax® model a V.24 or LAN connector is available.

Camera Con-
nector

Peripherals

Pin Signal Cable Color Pin

Refer to the Reference Manual for details.
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Pin Assignment »LAN« 
Cable

Camera Line Peripherals

View of the solder side of the socket

y
t

re
w
q

View of the front of the plug

1

8

For all Caminax® models with LAN

q T– Pink w

w T+ White/Pink q

e nc nc nc

r nc nc nc

t R– Green y

y R+ White/Green e

nc nc Blue r

nc nc White/Blue t

nc nc White/Brown u

nc nc Brown i

Ethernet Interface Usage

■ The LAN cable is available as an option. 
■ Uses of the cable:

❍ Configuration exchange with a PC. All Tasks and their settings can be stored on a 
PC for backup. Caminax® configurations can be cloned by loading the configuration 
from the PC to back to other Caminax® cameras. 

❍ Reference image transfer between PC and Caminax® 

❍ Ethernet based Task selection.

■ Connect the LAN cable to the Hirose socket on the camera, and the RJ45 plug on the 
other end to the internal network. 

■ A crossover adapter is needed for direct Caminax® - PC connection without Ethernet 
switch.

Camera Con-
nector

Peripherals

Pin Signal Cable Color Pin

Refer to the Reference Manual for details.
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Housing Dimensions

■ Dimensions 111 × 50 × 45 mm (without lens)
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